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Summary: This module describes the process and structure of work in Autodesk Revit 

software, using the example of the reconstruction of an industrial building in Chernivtsi. The 

stages of project implementation using digital technologies are described, and a 3D model of 

the object under study is created and printed. 

 

This module is devoted to the reconstruction of an industrial building, namely a brewery 

in Chernivtsi, which was carried out in Revit. In the process of developing the model, a partial 

reconstruction of the existing building was proposed with the additional construction of a new 

building nearby. 

The reconstruction of such an industrial facility is a complex project that required solving 

a number of specific tasks. Among them: 

• finding the best architectural and structural solution, taking into account the 

changed functionality of the building and design standards; 

• replacement of technological and related engineering equipment with modern 

equipment and the use of existing holes and shafts for laying the building's utility 

lines; 

• decisions on dismantling and replacing part of the building structures. 

Brief historical background. The first joint-stock brewery in Chernivtsi was built in 1869-

1871. The brewery is located north of the city centre, on the right bank of the Prut River, in 

close proximity to the railway and train station. It was founded by local entrepreneurs Heinrich 

Wagner, Markus Zucker, Isaac Rubinstein and architect Gregor. The association "Erste 

Bucowinaer Bierbrauerei - u.Spiritus-Industrie A.-G." had a statutory fund of 250 thousand 

florins. In the first year of exploitation, the brewery burned down. However, it was rebuilt and 

production resumed on 1 July 1877 (Fig. 1). 

 



 
   

                                                                
  

 
This project has been funded with support from the Erasmus+ Programme Key Action 2 Cooperation Partnerships for Higher Education 
(KA220-HED). This publication [communication] reflects the views only of the authors, and the Commission cannot be held responsible for 
any use which may be made of the information contained therein. 

                                                                                 
   

P
ag

e 
| 

4 

  

Fig. 1. Historical photographs of the brewery [12]. 

 

"Bavarian" beer was exported to Romania, Germany and Austria. Barley from Romania and 

Bessarabia, hops from the Czech Republic, and water from local artesian wells were used in 

its production. The development of the industry in western Ukraine is also evidenced by the 

fact that in 1911 Bukovyna and Lviv brewers united in the Galician-Bukovyna beer cartel. This 

meant a monopoly on the production and sale of beer in the region (Fig.2.). 

  
Fig. 2. Beer brands produced in Chernivtsi (from the collection of 

S. Nezhurbida) 

 

The brewery was largely developed during the period of its existence in the USSR. The 

brewery underwent a significant technical reconstruction. In 1994, the brewery was privatised 

by a leaseholder group and transformed into CJSC "Chernivtsi Brewery". In 1998, the project 
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"Technical Reconstruction of the Chernivtsi Brewery" was implemented, during which 

equipment from Germany and the Czech Republic was installed at the factory [11]. 

The facade of the production building is designed in the classicist style and is decorated 

with characteristic pilasters. To the left of the main building are two buildings with a gate 

between them. The balcony fence of the building to the right of the gate contains pseudo-

gothic elements. The arched windows of the building to the left of the gate refer to the 

Romanesque style. 

Chronology of names: Erste Bucowinaer Bierbrauerei, Bürgerlichen Bräuhaus Czernowitz, 

Beresa Cernāuţi, Chernivtsi Brewery, Chernivtsi Soft Drinks Factory, Chernivtsi Brewery JSC, 

"Rosy Bukovyny" Brewery JV. 

Nowadays, the factory is a closed and abandoned space (Fig. 3.). The decline of this 

industrial building due to a number of factors has turned it into a depressed and non-

functional territory. However, this building has historical and cultural value for the region. 

 

Fig. 3. The current condition of the brewery 

The main problem of the territory is its lack of maintenance and the ruined, burnt-out 

former factory, which in 2009 was decided to be used as a warehouse.  

The factory's territory is located at the intersection of all major transport routes - the main 

arteries of Chernivtsi, which connect the site with almost all districts of the city and border the 

historic part of the city (Fig. 4.). 
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Vokzal’na Street (formerly Gagarina Street) (Fig. 5.), where the factory is located, has a 

large daily traffic of cars and public transport from/to the historic city centre. There is a railway 

station, a bus station and public transport stops close to the research area. This indicates 

accessibility to the future public facility. 

According to the Chernivtsi City Zoning Scheme and the Chernivtsi City Master Plan 

(Fig. 6.), the site is located in a zone that allows for mixed multi-apartment residential and 

public buildings. 

 

Fig. 4. Situation scheme. Location of the project site in Chernivtsi [13]. 
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Fig. 5. The project site. Top view (Google Earth) 

  

Fig. 6. Chernivtsi City Master Plana and Chernivtsi City Zoning Scheme 



 
   

                                                                
  

 
This project has been funded with support from the Erasmus+ Programme Key Action 2 Cooperation Partnerships for Higher Education 
(KA220-HED). This publication [communication] reflects the views only of the authors, and the Commission cannot be held responsible for 
any use which may be made of the information contained therein. 

                                                                                 
   

P
ag

e 
| 

8 

1 Reconstruction of buildings using BIM technologies 

In 2022, the Verkhovna Rada supported Bill №6383 on the introduction of BIM 

technologies in Ukrainian construction. The explanatory note to the document states that its 

purpose is to create legal conditions for the use of modern building information modelling 

technologies as one of the key tools for further reform, modernisation and digital 

transformation of the construction industry in Ukraine. 

Such innovations will allow: 

• make the most efficient use of material and labour resources in the construction of 

facilities; 

• ensure the durability and safety of buildings; 

• minimise the negative impact on the environment; 

• accurately forecast and optimise costs at all stages of the facility's life cycle; 

• efficiently plan reconstruction and overhaul works. 

It is also a very relevant topic in the current realities of rebuilding Ukrainian cities. 

Reconstruction and restoration of buildings after military actions is becoming an important 

area of construction for residential buildings and large industrial structures.  

The BIM concept is based not only on a 3D model of a building, but also on the information 

contained in each component and element of this model. A smart model, which is an 

intellectual basis for decision-making, allows you to analyse a building object to meet the 

needs of different users, for example, to analyse the condition of structures or their damage, 

energy modelling, etc [14]. 

The main difference between reconstruction and new construction projects is the initial 

data collection, which is not always of high quality and often limited due to lack of information. 

One of the biggest constraints that currently exists for the building reconstruction process is 

the collection and integration of information for further use.  

The feature of buildings to be reconstructed and restored is that they have a complex 

structural scheme. Unlike new buildings, the components are not standardised. Moreover, 
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new solutions, structural components and various modifications are added to the design 

model. There is twice as much information as in a new building.  

A lot of problems also arise when reconstructing historic buildings, where it is important 

to preserve authenticity, recreate the facade and fit the building into the existing environment 

[15]. 

Automated BIM model creation for building and construction reconstruction means 

achieving optimisation that starts with data input (point clouds, images, videos) and ends with 

the finished BIM model, and in the intermediate processes, semi-automated or automated 

methods are applied to save effort and time, increasing efficiency. Photogrammetry and laser 

scanning have often been used together to survey complex or large buildings [16]. 

The general sequence of BIM for object reconstruction:  

• data collection using various technologies; 

• generation of a point cloud; 

• importing and processing the point cloud for semi-automatic recognition in the 

BIM environment;  

• semi-automatic generation of BIM elements;  

• create models for other components;  

• connecting all components to create a complete copy. 

Also, one of the most important principles underlying the concept of integrated 

reconstruction of buildings and structures is the principles of resource conservation and 

energy efficiency. Therefore, integrated reconstruction projects should be energy efficient. 

An energy-efficient project is a project aimed at reducing energy consumption, including 

the reconstruction of supply networks and systems, regulation and metering of water, gas, 

heat and electricity consumption, and modernisation of wall structures and production 

process technologies. 

When creating a BIM model, the principles of energy efficiency can be followed in the 

process of creating a project, where:  
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• an energy-efficient approach reduces the negative impact on the environment, 

which traditionally accounts for a significant percentage of the building industry; 

• comfort and microclimatic conditions of the buildings are improved, and hazardous 

factors are eliminated, which has a positive impact on health and quality of life; 

• the method of environmental and economic assessment of the life cycle of 

materials and structures is applied, which can significantly reduce the amount of 

waste and negative environmental impact at the stages of materials production, 

construction of buildings and reconstruction itself;  

• creating an attractive aesthetics of green building that can improve the social and 

emotional state of the population, and draw attention to environmental pollution 

problems and demonstrate ways to solve them;  

• the use of energy-efficient buildings will reduce dependence on imported energy 

and contribute to national security in general. 
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2 Purpose and functions of Autodesk Revit 

Autodesk Revit [1] is a software package that implements the principle of Building 

Information Modeling (BIM) to create visualisations and drawings of plans, sections, details, 

and other tools for building design. It is designed for architectural design, design of load-

bearing structures and utility networks, and supports sustainable design methods, conflict 

detection, construction and production planning. 

The building information model contains information about the construction of the 

project, its dimensions, stages, and quantitative characteristics of the elements [2]. Drawings 

created with Revit are not a collection of 2D lines and shapes. Any view, whether two- or three-

dimensional, detail, or specification is part of the same information model. 

The software includes easy-to-use conceptual design tools. It also allows you to visualise 

the model. Additionally, Autodesk Revit offers such functions necessary for architectural and 

design work as energy consumption calculation and structural analysis with the ability to 

perform static calculations in the cloud, especially important is the creation of a two-way 

connection between the model and various analyses and automatic updating of the model 

based on the results [3]. 

Building Information Model – BIM technology: 

• model is the simplest representation, a 2D or 3D model that is entered by the user 

into the design space.  

• information means that models in the design space are endowed with certain 

properties, in Revit these properties are called parameters. The difference 

between BIM programs and CAD programs is that the user can edit these 

parameters, as well as enter their own parameters for objects and change them 

during the design process. For example, the physical parameters of an object are 

width, length, height, material, etc., and the user can also enter parameters such 

as manufacturer, price, etc [4].  
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• building - the final result of the design process, which is a building - a set of various 

objects with their own properties that create a complete structure. As opposed to 

a conventional 3D editor, in a BIM program, each object is defined by the program 

or the user as a specific object with a specific function, rather than as a collection 

of polygons and planes. 

When you create a project in Revit, stage is important. Assigning elements to certain stages 

can be used to filter the visibility of these elements; stage is also reflected in the specifications. 

Stages are the stages of a project and reflect the creation and life cycle of the entire building 

and/or its elements. The breakdown into stages depends on the user - you can define stages 

by stage numbers or stage names ("Construction", "Existing building", "Demolition", etc.). 

They are linked to certain stages and, using stage filters, you can make parts of the project 

visible, invisible, or marked accordingly at different stages of the project. 

In general, the sequence of actions for creating a project in Revit is similar to other CAD 

software, with adjustments for Revit features. After setting up the workspace and creating 

basic elements (e.g. levels, etc.), as well as creating a construction site (may include a site 

drawing, topographic surface of the construction site, orientation to the cardinal points, etc. 

The next stage is the preparation of project documentation [28, 29]. 

Building a model can be started in one of two ways: by creating a conceptual model and 

then converting its parts into building elements (walls, roofs, etc.), or by creating a model from 

standard elements. In both cases, further work on refining the model will include the addition 

of typical elements - walls, partitions, roofs, windows, doors, etc. Also, work on the model will 

include adding and configuring new model views (facades, sections, details). In addition, in 

most cases, it will be necessary to use additional elements such as zones, stairs, and 

components such as furniture and equipment. 

When creating a model, you should take into account the need for several specialists to 

work simultaneously, as Revit is a BIM system designed for collaborative work [27]. 
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During the creation of a physical model of a building, its analytical model is also created - 

a simplified three-dimensional representation of the engineering and design description of the 

physical model of the load-bearing structures. The analytical model contains load-bearing 

elements, geometry, material properties and loads that form the building system. This data 

can be used to link the design with analysis and calculation programs for structural design. 

With the Advance Steel Extension for Revit, BIM data can be exchanged between Autodesk 

Revit and Autodesk Advance Steel, including elements such as steel beams, plates, timber and 

reinforced concrete elements, grids, and connection elements. 

Autodesk Revit provides tools for designing engineering systems for DOE buildings, such 

as air duct systems with mechanical air circulation, heating, cooling, electrical systems, and 

pipelines. It can be used in conjunction with other Autodesk products to create more 

coordinated models. 

A feature of Revit, in comparison with its closest competitors, such as Graphisoft 

Nemetschek Group, Nemetschek Allplan, Bentley Microstation, is a new concept of element 

structure and the use of a hierarchical project structure. At the very least, it does not have the 

usual means of distributing geometry - Layers - but instead has a whole hierarchy of 

Categories, Families, Types and Elements, as well as several methods for managing them [5]. 

Category is the systematic division of Autodesk Revit data by purpose (Wall, Window, 

Equipment, etc.). There are categories depending on the use: Models, Views, and Design. They 

have an individual set of properties and parameters, as well as behaviour and interaction 

conditions (Fig. 7.). Categories cannot be created and edited by users. 

Model categories include, as a rule, three-dimensional elements and are conventionally 

divided into Basic (Walls, Ceilings, Roofs, Stairs, Fences, etc.) and Components (Doors, 

Windows, Profiles, Equipment, etc.). 

The design categories usually include two-dimensional elements and are divided into 

Breakdowns (Levels, Axes, Reference planes, Reference lines, etc.) and Symbols (Dimensions, 

Text, Labels, Detailing, Lines, etc.). 
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View categories include data display elements (Plans, Facades, Sections, Nodes, Tables) at 

the required scale, display type, graphics, etc. 

Family is a "project" within a project or a "smart 3D model". A family is a group of elements 

that is characterised by a common set of properties (parameters) and their associated 

graphical representation. For different elements of the family, the values of the parameters 

may differ, but the set of parameters (their names and purpose) remain the same. 

 

Fig. 7. Categories 

Families can be windows, doors, cabinets, lamps, columns, facade elements, tiles, etc. 

There can be families within families. For example, window profile families are pulled into 
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window families. You can program families that will behave differently in certain situations. 

For example, if you look at a socket in a plan view, it has its own designation, in a section it 

has a different designation, and in 3D view it will be a three-dimensional model. Families are 

the "heart" of Revit, and it is families that allow you to make a project that is very flexible to 

adjust. 

There are three types of families in Revit: 

• system families; 

• families of standard components (component families); 

• сontext families. 

System families are used to create the main building elements, such as walls, roofs, 

ceilings, floors and other elements that are assembled on the construction site. System 

parameters that affect the project environment and include standard sizes for levels, grids, 

drawing sheets, and view screens are also system families. 

Standard component families are used to create both building components and some 

annotation elements. Typically, standard component families are used to create those building 

components that can be added separately, delivered and installed in or around a building, 

such as windows, doors, cabinets, appliances, furniture and landscaping components. These 

families may also include those annotation elements for which a standard adaptation 

procedure is provided, such as symbols and basic captions. 

Context families are unique and are used to create unique components designed for a 

specific project. Based on contextual families, you can create geometric objects that have 

references to geometric objects in another project and, when changes are made to them, are 

adjusted accordingly in size and other parameters. 

All content in a Revit project has parameters, which are simply information or data about 

something. Parameters can affect different aspects of an object, such as visibility, size, shape, 

and material. 
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To understand the fundamental concept of parameters, it should be noted that there are 

two types of parameters: type and instance. Type parameters manage information about each 

element of the same type. For example, if the material of a piece of furniture is designated as 

a type parameter, changing it will change the material for all furniture of that type. Instance 

parameters control only those cases that are selected. So, if the material of the selected 

furniture is an instance parameter, only the selected items will be edited. Instance parameters 

can be permanently displayed in the property’s palette. When you select something, the 

instance parameters are displayed first. In (Fig. 8.), the wall instance parameters are shown, 

which control the relative height, constraints, and structural use [7]. 

 

Fig. 8. Parameters of the wall instance 

Clicking the Edit Type button opens the type parameters (Fig. 9.). These parameters 

include the structure, graphics, and assembly code. 
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Fig. 9. Parameters of the wall type 

The element type provides an additional classification in the family categories and 

determines the behaviour of the family in the model. 

Elements are divided into three main types: 

• model elements; 

• basic elements; 

• type-specific elements. 

In this case, elements belong to families that define the main characteristics of all instances 

of these elements. 

Model elements include the actual parts of the virtual building - walls, roofs, columns, etc. 

These elements define the geometry of the building. 

Basic elements include parts of the virtual building's imaginary division that are used to 

describe the project, such as levels, grids, reference planes, etc. 

Type-specific elements, those parts of the project that are tied to certain types, such as 

dimensions, labels, are used to describe and document the project. They are displayed only 

on the views to which they are linked. 
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These types of elements are further subdivided into components: model elements, for 

example, are divided into main components and model components. The main components 

include walls, roofs, ceilings and floors - something that is created directly on the construction 

site. Model components include both load-bearing and non-load-bearing elements of building 

models, as well as elements such as beams, columns, braces, windows, doors, furniture, 

boilers, pipes, etc. 

View elements are also divided into annotation and information elements. The former 

includes 2D elements for documenting and scaling for printing - dimensions, grades; the latter 

include 2D elements for detailing and describing the model - detail lines, colour areas, 2D 

detail drawings. 

The behaviour of the elements will depend on the context, their creation, and whether 

they are set automatically or manually (Fig. 10.). 

 
Fig. 10. The "column" element in the Revit structure 

Rendering. After you create a building, model, or any other object in Revit, you can use the 

Revit rendering engine to create a more realistic representation. This is achieved using a 

specific set of tools and materials. Revit comes with a variety of predefined materials, each of 

which can be modified as the user wishes. It is possible to start with a "General" material and 
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set the angle, size, brightness and intensity of textures, glossy maps (also known as 

shinemaps), transparency maps, reflective, shear and other maps, or simply use sliders for any 

of the above texture features (Fig. 11.). 

 
Fig. 11. An example of a rendering in Revit [13]. 

2.1 Revit software interface 

From the Revit home page, you can do the following: 

• use the arrow at the top of the bar on the left to switch to the ribbon and the Revit 

user interface. 

• open a Revit model in the cloud if you have the appropriate access. 

• open or create a model or family. 

In the "Recent Files" section, open the created model or family. 

In the "Training" section, access interactive learning resources. 

The "File" tab provides access to file operations such as "Create", "Open", and "Save". It 

also allows you to manage files with advanced tools such as "Export" and "Publish". 
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The "Quick Access" panel contains a set of tools that are used by default. You can 

customise this panel to display the most frequently used tools.  

The "Info Centre" provides a set of tools for accessing various sources of information about 

the program.  

The "Project Manager" displays a logical hierarchy of all types, specifications, sheets, 

groups, and other project elements. By expanding categories, users can access their nested 

items.  

The status bar displays tips and tricks for the operations being performed. When an 

element or component is selected, the status bar displays its family name and size [9]. 

The options panel below the ribbon displays conditional tools that depend on the currently 

selected tool or element (Fig. 12.). 

 

Fig. 12. Elements of the Revit interface [13]. 
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Fig. 13. Project Manager Fig. 14. Properties 

palette  

Fig. 15. List of standard 

sizes 

The "Type selection" list displays the currently selected family size, and you can select 

another size in it (Fig. 13-15). 

The "Properties palette" is a dialogue box where you can view and change the parameters 

that define the properties of the elements. 
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The drawing area displays the views (as well as sheets and specifications) of the model. 

When you open a view in the model, the view is displayed in this area. 

When selecting an element near it, or directly on it, various control handles and shapes 

appear. Using the control handles, the shape and size of the elements can be changed. 

The toolbar contains all the most important tools you need to work with this application. 

The toolkit is divided into thematic categories. In particular, the toolbar contains the 

Architecture, Structures, Systems, Insertion, and Annotations sections. Tabs can be divided 

into two categories: contextual and static. Static tabs are fixed at their location and cannot be 

changed. Contextual tabs, on the other hand, are dynamic. They can be seen only when 

working with certain tools. These tabs include operations that are specific to the selected tools 

and elements. They close when you're done editing or using the tools. 

File formats. Revit supports a wide range of industry standards and file formats, including 

• Revit's own formats: RVT, RFA, RTE, RFT; 

• CAD formats: DGN, DWF, DWG, DXF, IFC, SAT and SKP; 

• image formats: BMP, PNG, JPG, JPEG and TIF; 

• other formats: ODBC, HTML, TXT and gbXML. 

Data can be imported into Revit from other CAD systems. The following CAD formats are 

supported: AutoCAD (DWG and DXF), MicroStation (DGN), SketchUp (SKP and DWG), SAT, and 

3DM (Rhinoceros) [9]. 

2.2 Import and export files 

Import CAD files into a Revit model using the Import CAD tool, which imports vector data 

from other CAD programs. It is also possible to import CAD files using i-drop technology. Revit 

supports importing files using drop points (Autodesk i-drop technology). Download point 

technology allows objects to be imported from web pages. 

Importing ACIS objects. ACIS objects describe bodies or bounded surfaces. Revit lets users 

import ACIS objects from DWG, DXF, DGN, and SAT files. 
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Import SketchUp files. You can include a TrimbleSketchUp project in a Revit project as a 

starting point for a building model. In Revit, the data imported from TrimbleSketchUp is 

treated as a large block of geometry that cannot be managed. However, to improve the 

results, it is possible to change the layer settings from TrimbleSketchUp. 

Import 3D shapes. 3D geometry can be imported from supported file formats and 

applications. When importing a file containing 3D objects, its format may support different 

geometry quality. These variations are caused by the file type, the export settings for the 

original application, and the Revit import settings [6]. 

In Revit models, information from IFC (Industry Foundation Classes) files can be used. 

Revit supports export to several computer-aided design (CAD) formats [8]. 

The DWG drawing format is the format of AutoCAD, as well as other CAD applications. 

The DXF data transfer format is an open format supported by many CAD applications. A 

DXF file is a text file that describes a 2D drawing. The text in such files is not compressed, so 

DXF files are usually large. When using the DXF format to export 3D drawings, cleaning may 

be required to ensure that the drawings display correctly. 

DGN is a file format supported by MicroStation software from Bentley Systems, Inc. 

SAT is an ACIS (solid state modelling technology) format supported by many CAD 

applications. 

When using the export tools while working with a 3D view, Revit exports the current 3D 

model, not its 2D representation. 
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3 Physical and architectural models of reconstruction of an 

industrial building in Chernivtsi 

The task in organising the reconstruction of this area was to create an environment that 

would combine and revive the surrounding existing buildings and be perceived as a single 

whole. The main idea was to fit the new building into the silhouette of the old industrial 

neighbourhood, the chimney and the factory facade, which are present on the site. Respect 

for the history of the building is not only about reconstructing and preserving its remains after 

the fire, but also about trying to continue the story, ultimately bringing the building back to 

life [13]. 

 
Fig. 16. Reconstruction project [13]. 
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The complex itself consists of two blocks, one historical and one modern, which contain 

two halls, united by a pavilion, which is a system of ramps (Fig. 16.). The ramp runs from the 

reconstructed building to the projected building and from the projected building leads to the 

winter garden. The projected complex can be used multifunctionally. For example, for large-

scale conferences, presentations, and exhibitions, it is also a place for walking, with open areas 

with landscaping. There is also a brewery museum, which stretches over 5-floors and leads to 

an observation deck where visitors can enjoy the views of the city of Chernivtsi [13]. 

Taking into account the current situation in Ukraine, such a project could have the 

following functions: housing for IDPs (Fig. 17.) [30], commercial or humanitarian hub [31] 

(Fig. 18.); employment centre with production and coworking (Fig. 19.), or have cultural and 

educational function (Fig. 20.) [25, 32]. 

 

Fig. 17. Housing for IDPs [13]. 
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Fig. 18. Commercial or humanitarian hub [13]. 

 

Fig. 19. Cultural and educational function [13]. 
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In general, the reconstruction of a brewery (Fig. 20.) is a more environmentally friendly 

option for redeveloping territories than demolition and construction.  

It helps to reduce the cost of reconstructing an industrial building, create the status of a 

cultural monument, attract additional investment in the project due to the "historical" object 

included in the complex, and preserve urban planning dominants [32].  

Currently, this industrial area, which has a good location near the city centre, should be 

allocated for commercial facilities, office centres, residential real estate and the development 

of the necessary infrastructure. 

Fig. 20. Final rendering [13]. 

3.1 Concept for the reconstruction of an industrial building using Autodesk Revit  

The architect has the ability to change the structure of any element using the extensive 

material database that is included in Revit, as well as create their own materials if necessary 

(Fig. 21.).  
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Fig. 21. Selection of construction materials 

Revit is characterised by great flexibility and advanced features for architects using this 

design and modelling software. The unique ability to change the structure of any element is 

one of the key advantages of Revit. Another undoubted advantage is the ability of architects 

to create their own materials independently of design engineers in accordance with the 

unique requirements of the project [10]. 

The architectural section (Fig. 22.) of a plan in three dimensions in Revit is a tool for 

detailed study and visualisation of a project. With this feature, users can easily create sections 

of a building plan and see their 3D model from different perspectives [21]. This not only helps 

to identify architectural details and connections, but also realistically reproduces the 

appearance and structure of the building. With 3D sections in Revit, it is possible to study 

project elements in three dimensions, thoroughly analyse spatial interactions, and influence 

design and functionality. This feature becomes an integral part of the design process, allowing 

you to accurately define concepts and solve architectural problems at the planning stage [33]. 
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Fig. 22. 3D section in Revit [13]. 

Revit provides users with a unique opportunity to effectively manage architectural 

elements in their projects, simplifying the design process and providing a high level of detail. 

Specifically, users can upload or create their own architectural elements such as doors, 

windows, furniture, and more, integrating them easily and accurately into their project [17]. 

This functionality is distinguished not only by a wide library of built-in objects, but also by 

the ability of users to make changes to existing elements or create their own. This is done in a 

user-friendly interface that allows you to adjust the parameters, dimensions, and appearance 

of the selected object in detail. This approach makes Revit an ideal tool for architects seeking 

maximum customisation and accurate translation of their concepts into virtual space [18]. 

Revit has advanced structural element management capabilities, providing engineers and 

architects with intuitive tools for modelling and optimising building structures [26]. The 

software allows users to choose from a variety of standard structural elements such as walls, 
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columns, beams, foundations, etc., or create custom designs to precisely meet the 

requirements of a particular project. 

One of the key advantages is the ability to record the physical and structural properties of 

building elements, providing a high degree of detail. Engineers can analyse the behaviour of 

structures under different loads and conditions, which allows them to optimise their efficiency 

and reliability. In addition, Revit integrates with other engineering tools, enabling convenient 

data exchange between design teams and simplifying collaboration during the design of 

building structures (Fig. 23.). 

 

Fig. 23. Design of structural elements [13]. 

Revit impresses with its integration and ability to allow structural engineers to actively 

interact and edit various structural elements, giving them a high degree of control over the 

project [19]. The design engineer can change the type and materials of structures 

independently of the architect to meet the technical and engineering requirements of the 

project (Fig. 24.). 
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A particularly important feature is the ability to reinforce reinforced concrete structures, 

where the design engineer can perform calculations and configure reinforcing elements 

directly in the programme [20]. This simplifies and streamlines the design process, allowing 

for accurate material consumption specifications for each structural element to be generated 

automatically.  

This approach ensures high efficiency and accuracy of design, allowing design engineers to 

effectively manage and optimise material consumption to achieve high quality and efficiency 

in construction [22]. 

 

Fig. 24. Wall reinforcement 

3.2 Description of the project implementation 

By default, when you start Revit, the Recent Files window opens (Fig. 25.). Resources area 

is on the right side. The upper area refers to projects, and the lower area refers to families. 
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Both areas display links to the four projects and four families that were opened most recently. 

Each area on the left side contains buttons for opening and creating projects and families [23]. 

 

Fig. 25. Revit initial window  

To create a new project, you need to execute the command Create → Project from the 

application menu. 

Double-click the left mouse button in the Project Manager to switch to the Site plan 

(Fig. 26.). The first thing to do is to draw the axes. To draw the axes, select the Architecture, 

Datum, Grid command (Fig. 27.). In the Modify | Place Grid tab, select the most convenient 

way to draw axes for a particular project (Fig. 28.). 
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Fig. 26. Project 

Manager 

Fig. 27. Axis command   Fig. 28. Edit tab | Grid coordinates 

To change the axis labelling, select the desired axis, then click on the label and change it. 

By default, the numbers are in numerical order and the letters are in alphabetical order [24] 

(Fig. 29.). 

 

Fig. 29. Axes, columns and dimensions on the plan [13]. 
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Select the command Annotate → Dimension → Aligned dimension to set the dimensions. 

By clicking on the axes in succession and making the last click in any free space, a dimensional 

chain can be added. To lock the resulting dimensions, click on the open padlock icon (appears 

when you select an axis). 

Next, it is necessary to calculate how high the floor will be and to mark the selected height, 

go to the Project browser - Project tab on the left panel and select any facade by clicking on 

Facades. By dragging the levels, it is possible to change the height, and by clicking on the level 

name, it can be edited (Fig. 30.) Also, levels can be added by the command Architecture → 

Datum → Level. 

 

Fig. 30. Levels on the Facades tab [13]. 

The axes are already there, but the bearing elements are missing. As is commonly known, 

it is more convenient to place columns on the plan, so in the Project browser - Project tab, 

select the level at which you want to place them. To place columns, go to the Architecture → 

Build tab and select the Column element. This element has two sub-elements: Structural 
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Column and Column: Architectural, which can be seen by clicking on the arrow next to the 

element.  

The difference between the elements is obvious, but by selecting any of these elements 

and clicking on the Properties tab → Edit Type, you can edit the parameters, rename and load 

other columns (Fig. 31.).  

 

Fig. 31. Properties of the "Column" element 

To draw walls, activate the Architecture → Build → Wall tool. In the left property panel, by 

clicking on the wall, select the one that suits most, or change the wall parameters in Properties 

→ Edit Type (Fig. 32.). 
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Fig. 32. Types of "Wall" elements 

Windows and doors are added from the Architecture → Build → Window / Door tabs, 

respectively. In the properties, it is possible to select a door or window from the proposed 

ones, add it from the library, and change the parameters. Select the desired element, place 

the cursor on the wall and drag it to the appropriate location. 

 

 

 



 
   

                                                                
  

 
This project has been funded with support from the Erasmus+ Programme Key Action 2 Cooperation Partnerships for Higher Education 
(KA220-HED). This publication [communication] reflects the views only of the authors, and the Commission cannot be held responsible for 
any use which may be made of the information contained therein. 

                                                                                 
   

P
ag

e 
| 

3
7 

To add a staircase, select Circulation → Stair from the same Architecture tab. Among the 

proposed components, select Stair by Component. This opens a contextual tab where it is 

possible to create a staircase using the necessary elements (Fig. 33.). 

 

Fig. 33. Context tab for editing a stairs 

 

Similarly, it is possible to create walls and place windows and doors on other floors by 

moving between them using the left pane of the Project browser - Project. 

In order to create a floor between stories, select the Architecture → Floor tab and select 

the desired floor (Fig. 34.). A contextual tab will open, where it is possible to choose a more 

convenient tool for setting the floor (Fig. 35.). 

 

 

Fig. 34. The "Floor" command  Fig.35. Contextual tab for editing  

 

To make an explication of all rooms, select the Room command on the Room and Area tab. 

The contextual tab opens, where the tools that can be used to create rooms are available 

(Fig. 36.). The name and number of the room can be edited by clicking on them. 
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Fig. 36. Room 

Next, go to the View → Create tab and select the Schedules/Quantities command (Fig. 37.). 

A window opens where in the Category section (Fig. 38.) select Rooms.  

 

 

 

Fig. 37. Schedules/Quantities Fig.38. Specification properties 

 

From the Available fields to the Scheduled fields, drag the parameters necessary for 

displaying in the specification (Fig. 39.), it can be edited in the Properties tab on the left panel 

(Fig. 40-41.). 
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Fig. 39. Specification properties  Fig.40. Specification of rooms 

 

 

Fig. 41. Part of the ground floor plan with specification [13]. 
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The axonometric view of the building can be shown by clicking on the 3D tab on the left 

tab of the Projectbrowser - Project (Fig. 42.). 

 

Fig. 42. 3D view [13]. 

The styles of displaying a 3D model can be changed in the Visual Style panel (Fig. 42-44). 

 

Fig. 43. Hidden line style [13]. 
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Fig. 44. Realistic style [13]. 

You can also create a custom style. To do this, select Graphic Display Options in the bottom 

Visual Style panel. 

If changing the materials is necessary, choose Manage → Settings → Materials. A window 

opens where the materials of the model can be configured (Fig. 45.). 

 

Fig. 45. Materials configuration window 
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In order to make a render, create a camera. Go to the View → Create tab and select 3D 

View → Camera (Fig. 46.). Place the camera in the desired location on the plan (Fig. 47.).  

 

 

 

Fig. 46. 3D views in the project manager  Fig.47. Installing a camera on a floor plan 

Next, in the left pane of the Projectbrowser - Project, in the 3D Views tab, select the newly 

created view (Fig. 48.).  

 

Fig. 48. View from the camera. 
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If more than one camera is created, the corresponding views will appear in this tab. After 

switching to one of the views, the view from the corresponding camera is displayed. The 

viewport boundaries can be changed by dragging them to any side. When the view is selected, 

click the Show Rendering Dialog command in the lower panel (Fig. 49.). 

 
Fig. 49. Visualisation dialogue box 

A window with rendering settings opens. Here it is possible to change the quality, 

resolution, lighting, and background. To start rendering, click the Render command on the 

panel (Fig. 50.). 

 

Fig. 50. The rendering process in Autodesk Revit [13]. 

When the rendering is complete, it can be exported to a computer or saved in the project. 

To transfer the materials created to a sheet, in the left pane of the Project browser - Project, 
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right-click on the Sheets tab and select New Sheet (Fig. 51.). A window opens where it is 

possible to select the desired sheet size or upload sheet (Fig. 52.). 

 

 

Fig. 51. Sheets tab Fig.52. The window for creating a new sheet 

The selected sheet should open in the workspace (Fig. 53.). 

 

Fig. 53. A blank sheet 
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To add plans, facades, and perspectives to a sheet, drag the corresponding elements from 

the Project browser - Project panel onto the sheet. Arrange the materials on the sheet. To edit 

any element, double-click on it with the left mouse button (Fig. 54.). 

 

Fig. 54. Completed architecture sheet [13]. 

In accordance with this module, a model of the reconstructed object was printed on a 3D 

printer at a scale of M 1:500 (Figs. 55-56.). 
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Fig. 55. The process of creating a 3D model 

 
Fig. 56. Finished 3D model 
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4 Сonclusions 

The following key advantages of Revit and BIM technology can be noted in the 

reconstruction of a brewery in Chernivtsi: 

• the information and architectural 3D model of the building makes it possible to 

compare the original object with the reconstruction project, to demonstrate 

architectural and engineering solutions; 

• collisions of a complex and voluminous engineering project, typical for industrial 

buildings, can be identified and corrected before it is transferred to the stage of 

actual reconstruction; 

• the adaptive properties of the information model allow all related sections of the 

project to be automatically updated when corrections are made to any of them; 

• Revit allows automatic generation of specifications for demolished objects, taking 

into account the types of structures, and thus calculates with great accuracy the 

volumes of building structures to be dismantled. 

Therefore, the reconstruction of the brewery's industrial building, and the factory's 

territory as a whole, in Chernivtsi, which was previously closed, is becoming a new place of 

attraction for the city's residents and opens up new opportunities for the reorganisation of 

the urban historical environment near the railway station.  
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